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1
Getting Started with 
Borland™ JBuilder™ 

Objectives
• To be able to register, install and activate the 

JBuilder 3.5 Enterprise Trial Edition.
• To understand and be able to use the JBuilder 

development environment.
• To be able to use JBuilder to create, compile and 

execute Java applications and applets.
• To be able to search and use JBuilder 

documentation effectively.
• To be able to use the debugger to locate program 

logic errors.
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1.1  Introduction
Welcome to the Borland™ JBuilder™ development environment. In this appendix you will
learn how to install the software included on the CD accompanying C How to Program:
Third Edition and how to create, compile and execute Java applications and applets using
Borland’s JBuilder. This appendix also introduces the JBuilder debugger and outlines the
JBuilder help documentation.

The software included on the CD is a 60-day trial version of JBuilder 3.5 Enterprise
Trial Edition. After 60 days, the license will expire and you will not be able to continue
using this software without purchasing JBuilder from Borland. For more information on
purchasing a copy of JBuilder, visit www.borland.com/JBuilder.

Before proceeding with this appendix, you should be familiar with the topics in
Chapter 24, “Introduction to Java Applications and Applets” and Chapter 25, “Beyond C
& C++ Operators Methods & Arrays in Java” of C How to Program: Third Edition.

If you are using Java How To Program: Third Edition, before proceeding, you should
be familiar with Chapter 1, “Introduction to Computers, the Internet and the Web,” Chapter
2, “Introduction to Java Applications” and Chapter 3, “Introduction to Java Applets.” Sec-
tions 1.9 and 1.10 of this appendix discuss more complex programs and before proceeding
with those, you should also familiarize yourself with the material in Chapter 4, “Control
Structures: Part 1,” Chapter 5, “Control Structures: Part 2" and through Section 6.6 of
Chapter 6, “Methods,” in Java How to Program: Third Edition. We hope you enjoy
learning about JBuilder.

1.2  Installation
The Borland JBuilder 3.5 Trial Edition is included on the CD accompanying C How to Pro-
gram: Third Edition. Before installing the compiler you must register it with Borland to ob-
tain a serial number and an activation key. An activation key is a unique sequence of letters
and numbers used to unlock JBuilder. To obtain an activation key, perform the following
steps:

1. Go to www.borland.com/JBuilder/v35trial.

2. Click the STEP 1 link to register or login as a Borland Community member.
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3. If you are already a member of the Borland Community, log in; otherwise, click
New User and fill out the forms which follow.

4. After successfully logging in, you will be asked to answer a questionnaire about
your intended use of JBuilder and Borland products. Fill out this questionnaire and
click Submit.

5. You will receive your activation key via e-mail. Enter the e-mail at which you
would like to receive your activation key and click Submit.

6. Borland will quickly send you your activation key. Check your e-mail to obtain it.

Once you have obtained an activation key, install JBuilder by performing the following
steps:

1. Go to the JBuilder\windows\foundation directory on your CD drive
and double click install.exe. [Note: JBuilder is also available for free down-
load at www.borland.com/JBuilder/foundation/download/win-
dows.html. After downloading the file, the rest of the installation should be
identical.]

2. After the install program has finished extracting files, select English and click
OK.

3. This displays the JBuilder Foundation Install dialog. Click Next to load the
licensing information.

4. After you have read the licensing agreement, check the I accept the license
agreement checkbox and click Next.

5. Choose a directory into which you will install JBuilder. It is recommended that
you use the default installation folder (Fig. 1.1)—c:\JBuilder35. The rest of
this appendix assumes that the default installation folder is used. Click Next to
continue.

6. The installation should now be complete. Click Done.

The JBuilder software has now been installed on your computer, but you must enter the
activation key obtained at the beginning of this section before you can begin programming.
To do so, 

1. Select Start, Programs, JBuilder 3.5 and Licensing Information from the
Start menu. This will launch the JBuilder Licensing dialog.

2. Click Add to enter your activation key.

3. Enter the serial number and activation key exactly as they appear in the e-mail you
received from Borland and click OK.

4. Check the I understand and agree with the license terms checkbox and
click OK.

5. You are now brought back to the JBuilder Licensing dialog. The table should
contain your activation key and trial information (Fig. 1.3). Click OK.
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Fig. 1.1 Choosing an installation folder.

Fig. 1.2 JBuilder Licensing dialog.
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Fig. 1.3 JBuilder Trial Edition licensing information.

You have now successfully registered, installed and activated JBuilder. If you are
having problems with any of these steps, Borland offers a variety of help resources. From
the JBuilder directory of the CD accompanying C How to Program: Third Edition, load
the Web page index.html (Fig. 1.4). This page contains system requirements for
JBuilder and provides links to instructions for installing JBuilder and additional installation
and configuration documentation. [Note: index.html provides system requirements and
installation instructions on multiple operating systems. Make sure to follow the directions
for Windows.] Additional information is also available at the JBuilder Trial Edition Web
site (www.borland.com/JBuilder/v35trial).

1.3  Integrated Development Environment Overview: JBuilder
Figure 1.5 shows a screen image of the Borland JBuilder integrated development environ-
ment (IDE). This environment contains everything you need to create Java programs—an
editor (for typing and correcting your Java programs), a compiler (for translating your Java
programs into machine language code), a debugger (for finding logic errors in your pro-
grams after they are compiled) and much more. The environment contains many buttons,
menus and other graphical user interface (GUI) elements you will use while editing, com-
piling and debugging your Java applications.

1.4  JBuilder Documentation
The documentation (help files) for JBuilder is also on the CD accompanying C How to Pro-
gram: Third Edition. This must be installed separately from JBuilder. To install the docu-
mentation:

1. Double click install.exe in the JBuilder\windows\docs directory on
your CD drive. [Note: JBuilder documentation is also available for free download
at www.borland.com/JBuilder/foundation/download/win-
dows.html. After downloading the file, the rest of the installation should be
identical.]
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2. After the installation program is done extracting files, select English and click
OK.

3. This will launch the JBuilder Documentation dialog. Click Next.

4. After reading the licensing agreement, check the I accept license agreement
checkbox and click Next.

5. Make sure that the directory to which you are installing the documentation is the
same as the directory to which you installed JBuilder (C:\JBuilder35) and
click Next.

6. After the installation is complete, click Done to exit.

Fig. 1.4 index.html, additional installation documentation.
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Fig. 1.5 JBuilder integrated development environment.

The documentation for JBuilder is now installed. To access the documentation, select
Help topics from the Help menu. This will load the JBuilder Help dialog (Fig 1.6).
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.

Fig. 1.6 JBuilder Help.

If you were unable to install the documentation successfully, the JBuilder Help
dialog displays the information shown in Fig. 1.7. Repeat the installation process, making
sure that you install the documentation in the same directory as JBuilder.
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Fig. 1.7 JBuilder Help dialog after an unsuccessful installation of the 
documentation.

The help documentation is easy to navigate and similar to a Web page. There are three
main parts to the documentation: the help toolbar, the navigation frame, and the content
frame.

The toolbar (Fig. 1.8) consists of five buttons: the Home button, which returns you to
the page displayed when the documentation is first loaded; the Back button, which returns
you to the last page viewed; the Forward button, which restores the page you were
viewing before pressing Back; the Print button, which prints the documentation being
viewed; and the Find button, which is used to find text within the current topic.

Fig. 1.8 The help documentation toolbar.

Home Forward

Print

Find

Back
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The navigation frame allows you to choose what page will be displayed in the content
frame, which provides the information. The homepage, Shortcuts to key topics, pro-
vides an overview of JBuilder, contains a link to the JBuilder homepage on www.bor-
land.com, introduces the new features of JBuilder 3 and explains how to use JBuilder’s
help documentation.

The navigation frame has three tabs located at its bottom: Contents, Index and Find.
The Contents tab is the default tab. It contains a hierarchy of information in the documen-
tation and serves as a table of contents. The six top level categories of information are
Quick Start, Building Applications with JBuilder, Tutorials, Getting Started
with Java, Java 2 Documentation and Java Language Specification. Double
clicking any of the books expands it into a listing of subcategories from which you can
select the topic you want to read about (Fig. 1.9)

You can select any of the topics which are displayed under a book to load information
about that topic in the content frame. The magnifying glasses that appear on the left can be
clicked to further expand a topic without selecting it. For example, to get information on
how to work with multiple projects, open the Quick Start book, click the magnifying glass
next to Working with projects, then click the magnifying glass next to Managing
projects and select Working with multiple projects (Fig. 1.10).

.

Fig. 1.9 Expansion of the Quick Start book.

Navigation frame

Content frameToolbar

Jbuilder.fm  Page 10  Thursday, December 14, 2000  1:15 PM



CHAPTER 1 11

©2000 Deitel & Associates, Inc.—All rights reserved.
©2000 Prentice Hall—All rights reserved.

Fig. 1.10 Help documentation on Working with multiple projects.

The Quick Start section of the documentation provides an introduction and overview
of the help documentation and JBuilder. It covers Working with projects and also intro-
duces many of the other topics discussed in this appendix, including Compiling Java
programs, Debugging Java programs and Working with Applets. It also provides
a tutorial on Building an Application.

The Building Applications with JBuilder section of the documentation provides
the detailed content for the sections introduced in Quick Start and also discusses Error
Messages and Warnings, Java Keywords and Handling of events. Other topics
listed are beyond the scope of this appendix.

The third section of the documentation provides three tutorials on how to use JBuilder
to create, compile and execute your Java Programs. The tutorials are: Building your first
application, Text editor and Nested layouts. The Building your first application
tutorial explains how to use JBuilder and how to use JBuilder to create GUI based applica-
tions. The Text editor tutorial provides the code for a text editing application and steps
you step-by-step through the creation of it. The Nested layouts tutorial steps you through
the creation of a complex user interface.

The final three sections of the documentation focus more on Java the language than on
JBuilder; they are provided as a reference to help you in your programming. Getting
Started with Java introduces Java programming. The final two sections (Java 2 Doc-
umentation and Java Language Specification) offer the Java 2 SDK, Standard Edi-
tion Documentation and the Java Language Specification. Both provide a comprehensive
and detailed break-down of Java and serve as definitive reference guides.
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The information in the help documentation can also be accessed through the Index tab
and the Find tab. The Index tab provides a searchable listing of topics discussed in the
JBuilder documentation. The Find tab allows the user to search through the documentation
for a word and return a listing of all the pages on which your text is found.

1.5  Creating and Executing a Non-graphical Java Application
You are now ready to create a Java application. Load JBuilder by selecting Start, Pro-
grams, the JBuilder 3.5 folder and then JBuilder 3.5 from the Start menu. This will
load the JBuilder integrated development environment (Fig. 1.11). JBuilder is preset to load
with a welcome project already open. Program files in JBuilder are grouped into projects.
A project is a text file that contains the names and locations of all its program files. Project
file names end with the.jpr extension. The project Welcome.jpr which is loaded, con-
sists of two files, Welcome.html and Welcome.java. Together these files create an
executable Java program.

Before writing any code, you should create your own project. Close the preset project
by selecting Close project: “Welcome.jpr” from the File menu. Then, click the File
menu and select New project... to launch the Project Wizard dialog (Fig. 1.12).

Enter the name of the project file you would like to create (it does not matter if this
directory does not already exist). We chose the path c:\javafiles\Welcome.jpr
(Fig. 1.12). Throughout the rest of this appendix, refers to this directory location.

Fig. 1.11 Welcome.jpr.
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.

Fig. 1.12 Project Wizard dialog.

If you select Next >, you will be asked to provide some information about the project
you are creating for commenting purposes. If you select Finish, the project file will be cre-
ated without the comments. After you create the project, your screen should look like the
one in Fig. 1.13.
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Fig. 1.13 JBuilder IDE after creating project Welcome.jpr.

Now you are ready to create the source file (a text file containing programming code)
for your program. This example will demonstrate how to create a simple Java application.
Section 1.7 will demonstrate how to create a Java applet and Section 1.8 will demonstrate
how to create an application with a GUI.

Select Open and Open file from the File menu. This will launch the Open File
dialog. Enter the File Name of the class you would like to create and click Open (Fig.
1.14).

We used the name /src/Welcome.java. All file names should be preceded by /
src/. It is important that your file name be in the src directory because that is the default
location where a project searches for source files. If your files are not in the src directory,
you will get a warning at compilation and your program may not execute correctly. If you
would like to place files elsewhere, you can do so, but you must change the path specified
in the Source tab in the Project Properties dialog. This is discussed is discussed in the
next section.

Because you are creating a new file, a dialog will appear, telling you that the file you
are attempting to open does not exist and asking you if you would like to create it. Click
OK. This will create the file Welcome.java. Your screen should now resemble Fig.
1.15.
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Fig. 1.14 Creating a Java source file Welcome.java.

Fig. 1.15 JBuilder IDE after creating Welcome.java.

The JBuilder IDE has now been divided into a bunch of different panes. For now, we
will focus on the content pane. The content pane displays all open files as tabs across its
top (i.e., Welcome.java) and allows you to edit them by typing or modifying text. Type

Welcome.java tab Content pane
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the following program (Welcome.java) into the content pane tab and save the program
by selecting Save from the File menu.

Before running the program, it is still necessary to add the file (Welcome.java) to
your project. To do so, select Add to project and Add file from the Project menu. Then
double click the src folder, select Welcome.java and click Open. You are now ready to
execute the program. Your screen should resemble Fig 1.16.

Fig. 1.16 Complete Welcome project.

1 // Welcome.java

2

3 public class Welcome {

4    public static void main( String args[] )

5    {

6       System.out.println( "Welcome to JBuilder!" );

7    }

8 }

code for Welcome.javaFiles included in project
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To compile your project, select Make project “Welcome.jpr” from the Project
menu. If there are no errors, then the status bar should say Build succeeded and dis-
play the number of seconds it took to build (shown in Fig. 1.20).

If there are errors in your code, they must be fixed before you are able to execute your
program. If your program contains errors, a Compiler tab will appear in the message pane
located at the bottom portion of your screen (Fig. 1.17). The compiler tab lists all the errors
in your program. For example, if we deleted the semi-colon from line 6 of our program, the
error message in Fig. 1.17 would be shown. An error message consists of a file name
(Welcome.java), an error number (200) and a line and column number (6 and 43). For
more information on an error, you can look up the error number in the help documentation.
If you click an error message, JBuilder will highlight the line of code containing the error
(also shown in Fig. 1.17).

Warnings are errors that do not prevent the compiler from being able to complete com-
pilation. If you received any warnings, they will be displayed in the Compiler tab. You
will still be able to execute your program without correcting these problems, but they
should be fixed whenever possible. Executing a program that contains warnings will often
lead to run-time errors—errors during the execution of a program. If you had any warnings
or errors in your program, fix them now and then select Make project: “Welcome.jpr”
from the Project menu.

Fig. 1.17 Compiling a program with errors.

Error message

Highlighted line of code

Message paneCompiler tab
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Before running your project you must specify more pieces of information. Select
Project properties... from the Project menu. This will launch the Project Properties
dialog (Fig. 1.18). click the Run tab and then click the Set... button. This specifies the
location of the main method for this project. It will open the Select Main Class for
Project dialog (Fig. 1.19). click Welcome and click OK. Now, click OK in the Project
Properties dialog and you will be ready to execute your program.

Fig. 1.18 Project Properties dialog.
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Fig. 1.19 Selecting the Welcome class as the location of the main method.

Select Run project from the Run menu. This executes the program and opens the
message pane (Fig. 1.20) where the output is displayed. The message pane contains a line
of text specifying what was executed and the output for your program, “Welcome to
JBuilder!”.

Jbuilder.fm  Page 19  Thursday, December 14, 2000  1:15 PM



20 CHAPTER 1

©2000 Deitel & Associates, Inc.—All rights reserved.
©2000 Prentice Hall—All rights reserved.

Fig. 1.20 JBuilder IDE after running the Welcome project.

If you are still having problems creating, compiling or running your programs consult
the JBuilder help documentation for more information. For information on creating a
project with multiple source files, see Section 1.10.

1.6  JBuilder Features
JBuilder has many features that make writing programs easier. In this section, we hope to
introduce you to some of the most important ones, some of which you may have already
noticed.

The JBuilder development environment is divided up into many different subsections
called panes. Figure 1.21 is a screen shot of JBuilder with all of its panes loaded.

Status bar Program output Compilation information
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Fig. 1.21 JBuilder IDE with all panes showing.

The project pane provides information about the current project and allows you to
organize it. It lists all of the files in the current project, providing a unique icon for every
different file type to make them easily distinguishable. Double clicking any of the files
listed in the project pane causes that file to be displayed in the content pane. Right-clicking
on any of the files in the project pane generates a pop-up window allowing you to make
decisions regarding that file.

The structure pane provides a break-down of the project in the project pane. It lists all
of the classes and methods in the project in a hierarchal order. If you double click one of
these classes or methods, the file containing that class or method will be opened and you
will be brought to the line beginning the class or method. The line will also be highlighted
in yellow for increased visibility. Another feature of the structure pane that you may have
noticed in the previous section is the Errors folder (shown in Fig. 1.22), which opens when
there are problems with your code. This feature informs you of problems in your code as
you are programming so that you do not need to fix them all at once when compiling.
Clicking an error causes the line on which the error occurred will be displayed.

The content pane serves as the text editor for the JBuilder development environment
and also provides many helpful aids for program design. All open files are displayed in the
content pane, with tabs listing the file names going across the top of the pane. You can click
these tabs to switch between files. At the bottom of the content pane are a status bar and
another set of tabs. The status bar lists the file name, the line and column number of the

Project pane Content pane

Structure pane Message pane

Content pane’s status bar

Status bar
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cursor, whether the file has been modified since the last save and whether you will be
inserting new text or overwriting the existing text when you type. The tabs at the bottom of
the content pane are beyond the scope of this appendix. For a .java file, the Source tab
should always be selected. For more information on tabs, consult the help documentation.

You are already familiar with the message pane from the previous section. It displays
error messages and warnings, allows for input and output through System.out and
System.in and conveys all messages from the computer to the programmer.

Now that you are familiar with all of the panes and major sections of the JBuilder
development environment, we will discuss a few of its other features.

While you were entering the text for your program in the previous section, you prob-
ably noticed the CodeInsight feature. As you are typing, every time you code a class,
method, or parameter reference JBuilder will open a pop-up window with all of the legal
choices to complete your statement (Fig. 1.22). This feature will save you time as you are
typing in your code and will also ensure that your references are correct. Clicking an item
in the pop-up window causes the text to be inserted at the current cursor position.

Fig. 1.22 CodeInsight.

CodeInsight pop-up windowErrors folder
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While you were typing the text for the previous problem, you also probably noticed
that some of your code changed color. This is called syntax color highlighting and is
designed to make reading code easier. Comments are highlighted in green, keywords in
blue, text in black and strings in light blue.

The final feature we will discuss is the Project Properties dialog (Fig. 1.23).
Selecting of Project properties... from the Project menu opens a dialog window that
allows you to configure your file. The Paths tab allows you to modify the version of JDK
you are using, choose where to direct your output, and modify the directories being used to
search for source files (Source tab), documentation files (Documentation tab) and
library files (Required Libraries tab). The Run tab allows you to set options for your
application or applet. The Debug, Compiler, Build and Code Style tabs all allow you
to further customize your project.

Fig. 1.23 Project Properties dialog.

Paths tab

Run tab Debug tab Compiler tab Build tab

Code Style tab
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There are many additional features included in JBuilder 3.5. The most significant is
probably that JBuilder provides many GUIs and Java classes to facilitate your program-
ming. You can access these by selecting New... from the File menu. For more information
on additional features in JBuilder 3.5, access the help documentation.

1.7  Creating and Executing a Java Applet
This section will demonstrate how to create and run a Java applet. Unlike a Java application
that executes from a command window, an applet is a Java program that runs in the applet-
viewer (a test utility for applets that is included with all Java software) or a World Wide
Web browser such as Netscape Communicator or Microsoft Internet Explorer. Applets are
most commonly used inside Web pages and also add graphical capabilities to Java pro-
gramming.

To create a Java Applet, create a new project and a new .java file following the steps
in Section 1.5. In this example, we named our new project and .java file WelcomeAp-
plet.jpr and WelcomeApplet.java, respectively. After creating these files, type
the following program into WelcomeApplet.java.

Before compiling and running your applet, you must add the file to your project, as was
done in Section 1.5, and you also must specify the main method. Specifying the main
method is slightly different for a Java applet. Select Project properties... from the
Project menu and click the Run tab. Then click the Applet tab and set the main method.
In Section 1.5 we set the main method under the Application tab, now we want to set the
main method under the Applet tab (Fig. 1.24).

Now, you should be ready to compile and execute your Java applet. Compilation and
execution is performed the same way as in Section 1.5. Select Make project “Welcome-
Applet.jpr” from the Project menu and then select Run project from the Run menu.
The output should resemble Fig. 1.25.

Applets may also be created using the Applet Wizard. To use the Applet Wizard,
select New... from the File menu and select Applet from the resulting dialog. For more
information on the Applet Wizard, consult the help documentation.

1 // WelcomeApplet.java

2

3 import javax.swing.JApplet;    // import class JApplet

4 import java.awt.Graphics;      // import class Graphics

5

6 public class WelcomeApplet extends JApplet {

7    public void paint( Graphics g )

8    {

9       g.drawString( "Welcome, from an Applet!", 25, 25 );

10    }

11 }
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Fig. 1.24 Setting the main method for a Java applet.

Fig. 1.25 Output from running WelcomeApplet.
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1.8  Creating and Executing a Java GUI
This section will demonstrate how to create and execute a Java Graphical User Interface
(GUI). GUIs are used to create windows and handle mouse clicks and other events. When
creating a GUI, follow exactly the same steps followed in Section 1.4. The only differences
are in the source code and output.

Create a new project and a new.java file. In this example, We name ours gui.jpr
and gui.java. Type the following code into gui.java.

Add the file to the project and set the main method in the Application tab. Then
select Make project “gui.jpr” from the Project menu and select Run project from the
Run menu. The output should appear as Fig. 1.26.

As was mentioned earlier, JBuilder provides many GUI classes. To access the GUIs,
select New... from the File menu. From this menu, you can create a new class, dialog,
frame, panel or application which is based on a pre-made template. To do so, make the
appropriate choice, click OK and a Wizard will launch to help you in your setup. For more
information on the GUI classes and pre-made templates, consult the help documentation.

Fig. 1.26 Output from executing the gui project.

1 // Welcome from a GUI

2

3 import javax.swing.JOptionPane;     // import class JOptionPane

4

5 public class gui {

6    public static void main( String args[] )

7    {

8       JOptionPane.showMessageDialog(

9          null, "Welcome from a GUI" );

10

11       System.exit( 0 );             // terminate the program

12    }

13 }
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1.9  Debugger
The JBuilder IDE provides a debugger tool to help the programmer find run-time logic er-
rors in programs that compile successfully but do not produce expected results. The debug-
ger lets the programmer view the executing program and its data as the programmer runs
either one step at a time or at full speed. The program stops on a selected line of code or
upon a fatal run-time error. When the programmer does not understand how incorrect re-
sults are produced by a program, running the program one statement at a time and monitor-
ing the intermediate results can help the programmer isolate the cause of the error.

To use the debugger, set one or more breakpoints. Line breakpoints are the most com-
monly used type of breakpoint. A line breakpoint is a marker set at a specified line of code
that causes the debugger to suspend execution of the program upon reaching that line of
code. A line breakpoint is set by clicking the line and pressing F5, by right clicking the line
and selecting Toggle breakpoint from the resulting pop-up menu or by selecting Add
breakpoint from the Run menu and Add line breakpoint... from the resulting menu.
The third method of setting a line breakpoint launches the Add Line Breakpoint dialog
(Fig 1.27). Specify the class and the line number on which the breakpoint is to appear and
click OK.

JBuilder provides four different types of breakpoints. A line breakpoint, already dis-
cussed, instructs the debugger to stop when it reaches a specified line. An exception break-
point instates the debugger to stop when an exception is about to be thrown. A class
breakpoint instructs the debugger to stop upon loading a specified class or when one of the
class’s methods is called. A method breakpoint instructs the debugger to stop when a spec-
ified method is called. Any of these breakpoints may be added by selecting Add break-
point from the Run menu, which will open a dialog allowing you to configure the
breakpoint. 

When a breakpoint is set, a solid red circle appears in the margin next to the content
pane and the line it is set on is highlighted in red (Fig. 1.28). Breakpoints are removed by
clicking the line with the breakpoint, right clicking and selecting Toggle breakpoint or
pressing the F5 key. 

Fig. 1.27 Adding a line breakpoint.
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.

Fig. 1.28 Program with a breakpoint.

Selecting Debug project from the Run menu starts the debugging process. Program
execution suspends for input and at breakpoints. A green arrow (Fig. 1.29) is used to show
where the program control is and a debug window appears in the message pane. The state-
ment to which the green arrow points (y = square( x );) is the next statement to be exe-
cuted.

Breakpoint
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Fig. 1.29 JBuilder IDE during a debugging session.

The toolbar on the left allows you to toggle the debugger display area. The table in Fig.
1.30 summarizes its actions. We will examine the Watch and Thread displays in greater
detail.

Icon Name Function

Console input, output and 
errors view

Displays output and errors from the program and handles 
all input to the program during a debugging session.

Threads, call stacks and 
data view

Displays the threads and traces of the call sequence to all 
frames.

Synchronization monitors 
view

Used to detect lock-ups. A lock-up is when the program 
execution never terminates, usually because of an infinite 
loop.

Fig. 1.30 Debugger display tabs. (part 1 of 2)

Program control arrow

Debugger display tabs Debug toolbar
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Often, certain variables are monitored by the programmer during debugging—a pro-
cess known as setting a watch. The Watch window allows the user to watch variables as
their values change. Changes are displayed in the Watch window. A watch is set by
selecting Add watch... from the Run menu while the debugger is executing, or by
clicking the Add watch icon (see Fig. 1.35). This launches the Add Watch dialog (Fig.
1.31) window, where you enter the expression you would like to watch and a description
of it. We decided to track variable y and use the description tracking y. 

Switch the debugger view to the Watch tab and you will be able to track the value of
y throughout the program (Fig. 1.32). Right clicking a watch will load a pop-up window
(Fig. 1.33) allowing you to manipulate the watch. By clicking Change value..., you can
actually change the value of the variable in your code in the middle of execution. This can
be useful for testing and debugging purposes. 

Fig. 1.31 Adding a new watch.

Data watches view Displays descriptions and values of all watches.

Load classes and static 
data view

Shows the classes currently being used by the program 
and any static data in that class.

Data and code breakpoints 
view.

Shows breakpoints and their set state.

Classes with tracing dis-
abled view.

Lists all the classes which it is advised are not stepped 
into.

Icon Name Function

Fig. 1.30 Debugger display tabs. (part 2 of 2)
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Fig. 1.32 The Watch tab.

Fig. 1.33 The Watch pop-up menu.

The Thread tab allows you to drill down and determine the calling sequence in your
program. If we wanted to determine what y was equal to and its scope, we could use the
Thread tab and expand system all the way (Fig. 1.34).

Fig. 1.34 The Thread tab.
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The Debug toolbar contains buttons that control the debugging process. These buttons
perform many of the same actions as the options in the Run menu. Each button is labeled
in Fig. 1.35.

The Reset program button terminates a debugging session.
The Resume program button restarts program execution. If you are paused at a

breakpoint and press the Resume program button then execution will continue until
either the next breakpoint or the end of the program. If you have stopped debugging using
the Reset program button, then the Resume program button will launch a new debug-
ging session. The Pause button can be used to pause a debugging session.

The Smart Step button toggles whether or not Smart Step is activated. Smart Step is
a feature of JBuilder that causes the debugger to skip over code through which it is unlikely
that you need to step.

The Step Over button executes the next executable line of code and advances the
green arrow to the following executable line in the program. If the line of code contains a
function call, the function is executed in its entirety as one step. This allows the user to exe-
cute the program one line at a time and examine the execution of the program without
seeing the details of every function that is called.

The Step Into button executes program statements, one per click, including code in
functions that are called, allowing the programmer to confirm the proper execution of the
function, line-by-line. Figure 1.36 shows the results of pressing the Step Into button
before execution of the square function in our code

Fig. 1.35 The Debug toolbar.

Resume program

Pause Step Over

Step Into

Step Out

Add line breakpoint

Add watch

Show current frame

Smart Step

Reset program
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.

Fig. 1.36 Stepping into function square.

The Step Out button allows the user to step out of the current function and return con-
trol back to the line that called the function. If you Step In to a function that you do not
need to examine, click Step Out to return to the caller. 

The Add line breakpoint and Add watch features have already been discussed.
These buttons provide an easier way to access those features. The Show current frame
button loads the Thread tab and expands it to the current frame.

Other debugging features which are not included in the toolbar can be accessed
through the Run menu. These include Run to cursor, Run to end of method, Show
execution point and Evaluate/modify.

Run to cursor causes the debugger to execute all code up to the cursor and then pause
as if a breakpoint had been placed at the current cursor location. Run to end of method
causes the debugger to complete execution of the current method.

Show execution point (the line pointed to by the green arrow) displays the file con-
taining the point in program execution at which you are paused in the content frame.

Evaluate/modify is similar to a watch. The only difference is that it is temporary and
does not stay throughout the rest of the debugging session. By selecting Evaluate/modify
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from the Run menu, you load the Evaluate/Modify dialog (Fig. 1.37). Here you can enter
an expression and then either evaluate it or change its value.

Breakpoints have additional functionality that has not yet been discussed. Load the
Add Line Breakpoint dialog by clicking the Add line breakpoint icon on the toolbar
(Fig. 1.35). You will notice that there are two fields at the bottom of the dialog, Condition
and Pass Count.

Condition allows you to set an expression which when evaluated will determine
whether the debugger should pause at this break point or continue as if it did not exist. If
the expression evaluates to true, the debugger will pause. For example, we could set the
condition of our breakpoint to x > 5 and then the debugger would only pause at the break-
point if x were greater than 5 (it is not in our example, so the program executes without
pausing).

The Pass Count option allows you to specify how many times the line of code must
be executed before the debugger pauses. This is useful in programs with loops. If we
wanted to stop program execution after five iterations through the program in Fig. 1.38 then
we would set the count to 5. The result of running the debugger (with a watch on variable
sum) can be seen in Fig. 1.39.

Fig. 1.37 Evaluate/Modify dialog.
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Fig. 1.38 Program debug_02.java.
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Fig. 1.39 Debugger pausing after four iterations.

The debugger pauses when about to execute the statement sum += i; for the fifth
time. Therefore, because the statement has been executed four times, the value of sum is
10.

To end a debugging session press the Reset program button. The debugger will stop
automatically whenever the last line of code is executed. For more information on the
debugger and debugging options, please consult the help documentation.

1.10  Creating a Java Application with Multiple Source Files
Many complex Java programs contain multiple source files. This section outlines how to
create and compile a Java application with multiple source files using JBuilder.

Create a new project as was done in Section 1.5. Then create two new .java files. In
this example, we created MultipleFiles.java and Square.java. Add both files
to the project. Then, configure the project properties and point the Main Class: to the file
which contains the main method (in this example MultipleFiles.java). Follow the
same steps as in Section 1.5 to make the project and run it. Figure 1.40 shows a screen shot
of the MultipleFiles project and its output.
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Fig. 1.40 A project with multiple source files.
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